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TotalChrom Operational Notes

TotalChrom™ Tips
Introduction

T

he information and tips in this document are intended to provide some
helpful ways for the user of the TotalChrom™ chromatography software to
generate and optimize their methods, reports and sequences and in review
of their data.

Pictured below is the TotalChrom Navigator screen. These system functions are
accessed by a single click on the screen buttons. These functions are labeled with
blue group names and can also be accessed from the drop-down menus of the
same name.
For example the Build group for the function Method, Graphic Edit, Sequence
and Report Format are also available in the Build drop-down menu.
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Chapter 1 - File Management Tips
1. Create TotalChrom Folders
There are many ways for set up your system file structure. Here are three
examples of basic TotalChrom file management structures. As a start you should
create folders for Data, Methods & Report Formats and Sequences.
Tip #1- Create separate folders for your TotalChrom data, methods & reports and
sequences on the C:\ drive. This will allow for shorter directory paths for easier
viewing in the TC sequence screen and in report headers.
This structure will also prevent possible deletion of system files that are stored in
the PenExe folder. It is NOT a good idea to use the TotalChrom PenExe program
folder for this reason.

1.

Use Windows Explorer to create new folders in the
C:\ Drive.
Some examples are:
C:\TotalChrom Data or C:\TC Data
C:\TotalChrom Methods & Reports
C:\TotalChrom Sequences

Tip #2 - Always save your Method and Report Format files together in the
same folder so that the TotalChrom software can always find your
Report Format files.

2. Segment Your TC Data Files.
For large numbers of TC data files you may want to segment your
data files by year or year & month, by instrument name or by
analysis or product name as in the examples below:
C:\TotalChrom Data\2008
C:\TotalChrom Data\2008\June
C:\GC 1 – QC Lab
C:\Your Analysis or Product
Tip #3 - The more you segment your data into separate folders, the easier
it will be to retrieve your data for review and reprocessing or to
move you data for archival purposes.
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Chapter 1 - File Management Tips
3. TotalChrom - Project Directory function.
At times it may be useful to group all of your file types into
a specific folder.
Tip #4 - Use the Project Directory function. This is a
quick and convenient way to store and archive all the files
associated with a specific project e.g. Methods, Report Formats,
Data and Sequences. Check this out it may be useful for you!
Step 1. Open Windows™ Explorer and create a Project name.
Example: C:\My TotalChrom Project Directory
Step 2. In TotalChrom Navigator Screen
a. Click on the Build drop-down menu.
b. Select the Configuration function.
c. Select User and then Project Directory.
d. Select your previous created Project Directory using the
browse button.

TotalChrom - Project Directory Setup window.

Note: You may need to use Save As to save your first file entered
into a newly created project directory before your files will be
automatically saved in your new project directory instead of in the
TotalChrom default paths.
4
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Chapter 1 - File Management Tips
4. TotalChrom Quick Paths.
Tip #5: Setup TotalChrom Quick Paths. This is a quick
and convenient way to easily select a directory path within
TotalChrom. This can be used to save or look for data files
and to look up method and sequence files.
Step 1. In the TotalChrom Navigator Screen:
a. Click on the Build drop-down menu.
b. Select the Configuration function.
c. Select User and then Quick Paths.
d. Use the Add button to find and add your most
frequently used directories to Quick Paths list. Click
OK when finished.

TotalChrom - Build/Configuration/User/Quick Paths window.
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Chapter 1 - File Management Tips
4. Setup TotalChrom Quick Paths - continued.
Setting up Quick Paths for your most frequently used methods,
sequences and data directories is a big time saver over the long run.
Step 2. Use the Quick paths function in any TotalChrom File-Open
window.
a. Click on the Quick paths browse button.
b. Select the directory of interest from your list.

Using the Quick path function in TotalChrom File-Open
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Chapter 1 - File Management Tips
5. Create a Backup Folder.
Tip #6 - It is highly recommended that you create a backup
folder for your finished and optimized methods, report
formats and sequences.
Use Windows™ Explorer to create this folder. These backup files will come
in very useful if a method file is accidentally changed, lost or is corrupted.
Step 1. Open Windows™ Explorer and create a backup directory
name. For example:
C:\TotalChrom Backup
Step 2. When you are satisfied that your method, report format
and sequence files are finished copy them to your
backup directory. You can use the Windows Save As
function as follows:
a. Click on the File drop-down menu.
b. Select Save As …
c. Save your file to the TotalChrom Backup directory.
Tip #7 - It is also highly recommended that you backup all important files
off-line in case of hard drive failure. Use removable storage
media such as a flash drive, CD or floppy disk.
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Chapter 1 - File Management Tips
6. Set up Default Paths - System Configuration
Tip #8 - If you have TotalChrom administrator (manager)
privileges you can setup or change the default paths for
your method, report and sequence files as needed in
System Configuration.
a. In the TotalChrom Navigator screen select the System Configuration
function from the Admin drop-down menu.
b. Highlight the User - Manager and select the Users tab.
c. Click on the Default Paths/Base Names button. Using the browse
button, select your new default data paths. Use the same path for both
Raw data and Result files.

TC Navigator/Admin/System Configuration window.

Important Note: It is recommended that you do not change the paths for
methods and report formats or sequences once they are
setup.
8
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Chapter 1 - File Management Tips
6. Set up Default Paths – continued
After default Raw and Result data paths have been
created in Windows™ Explorer they can be entered here by
using the browse buttons. It is highly recommended that
you use the same folder for both file types.
As an example, you can add the year to your Raw and Result file data
paths.
Example: C:\2008 TC Data

TotalChrom Default Paths/Base Names Window

Note: Consider using the Projects Directory function that is discussed
in Section 3 if you need to group all of your file types together.
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Chapter 2
Chapter 2 – Method Tips
1. TotalChrom Method Editing - Introduction
There are many ways to edit your TotalChrom methods. Method editing can be
performed either manually using the Method Editor functions or graphically using
the Graphic Method Editor functions.
1. Manual method editing.
You can access the Method Editor functions by single clicking
on the TC Navigator Build - Method button or by selecting
Method from the Build drop-down menu.

TotalChrom Navigator screen - Method Editor.

Tip #9 - Use the Review function in the Method Editor File drop-down menu.
This will step you through each page of the method. Don’t forget to
click on each of the tabs to review all of the method parameters.
10
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2. Instrument Parameters – Data Channels
Tip #10 - Use Data Channel-A when only a single detector method is used even
if the Source channel is the “B” detector. This will allow you to use the
Channel-A Sequence for method setup.
Note: Setting the TotalChrom data Sampling Rate parameter correctly is
very important for proper data acquisition and subsequent peak integration.
1. Data Channels – Setting the Sampling Rate
Tip #11 - Set the Sampling Rate so that your narrowest,
and smallest, peak of interest will have at least 15 – 40 data
points in the main body of the peak. Do not include peak
tailing data points for this initial setting of the sampling rate.

Method Editor - Instrument – Data Channels screen.

Example:

If a capillary peak is 3 - 6 seconds wide at its base, set the
sampling rate to 6.25 data points/sec.
4 sec. X 6.25 data points/sec. will give 25 data points/peak.
11
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Chapter 2 – Method Tips
2. Instrument – Data Channels - continued
Setting the TotalChrom data Sampling Rate parameter correctly is very important
for proper data acquisition and subsequent peak area integration.
2. Data Sampling Rate set too low.
The TotalChrom Sampling Rate is set in points/second
(pts/sec) or hertz. This parameter determines the number
of data points stored in the .Raw data files.
If the Sampling Rate is set too slow, the peak data at the crest of the
peaks of interest will not be properly collected resulting in accurate
and low area counts.

Example of Sampling Rate set too low. Note that the data at the crest of the
peak was not collected!

Important Note: If the Sampling Rate is too low (slow) the peak
crest data points may be missed causing
inaccurate peak area (low) measurements.
On the other hand, setting the Sampling Rate too high (fast) and collecting
too many data points will result in .Raw data files that are overly large and
can result in peak splitting.

Tip #12 – Use the Graphic Method Editor to view (and count) the actual raw
data points in your data file. See Chapter 3, page 31.
12

Chromlab

TotalChrom Operational Notes

Chapter 2 – Method Tips
2. Instrument – Data Channels - continued
3. Data Sampling Rate set too high.
The TotalChrom Sampling Rate is set in points/second
(pts/sec) or hertz. This parameter determines the number
of data points stored in the .Raw data files.
Setting the Sampling Rate too high or over sampling can result in your method
being over sensitive to detector noise that may result in peak splitting during
integration.

Example of the Sampling Rate set too high (fast). Note that this peak is
split and will be identified as two separate peaks in the report.

Important Note: If the Sampling Rate is too high (fast) your data
file size will be overly large and peak splitting
may occur.
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3. Instrument Control Options – Oven/Inlets
Tip #13 - Set the GC Oven parameters Max. Temp to protect your column
liquid phase from being over-heated and Equilibration Time to
stabilize the column oven temperature before the run start.
1. Setting Oven/Inlets parameters
a. Set the Oven – Max. Temp. (°C.) at 20 - 50° C. above
the oven program final temperature, but never more than
the column liquid phase max temperature.
b. Set the Oven – Equilibration time (min) to at least 1 or 2 minutes
when using a low initial oven temperature (35 - 50° C.) to allow the oven
air and column temperature to stabilize before the start of a new injection.

Method Editor – Instrument – Control Options – Oven/Inlets.
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4. Instrument Control Options – Detectors
Tip #14 - The FID detector Temperature, Range and Time constant
parameters must be set correctly for the column type installed.
1. Setting up the Detector parameters.
a. Set the Detectors - Temp. (°C.) at 20 - 50° C. above
the oven program final temperature to prevent moisture and
sample contamination from building up on the FID jet tip.
b. Use Range 1 for most capillary column installations, use Range 20 for
packed columns.
c. Set the Time constant to 50 when using high-efficiency capillary
columns that produce fast, narrow peaks to prevent signal loss at the top.

Method Editor – Instrument – Control Options – Detectors.
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5. Instrument Control Options – Inst Timed Events
Tip #15 – Setup a Split flow gas saving mode in your method. You can
modify a method to automatically reduce the split flow setting after the
injection to save carrier gas. Use the Inst Timed Events functions for
this mode of operation. Note: The GC must have programmable
pressure control (PPC) in order to set up this feature.
Step 1. Set up Gas Saving mode Timed Events.
a. Select the SPL1 (or SPL 2) function with the Event
browse button. Set the Time (min) to -0.5 min and the
Value which will be your injector split flow at 50 – 100
mL/min and click on the Add button.
b. Again select the SPL1 (or SPL 2) function and set the Time (min) to
2.00 minutes and the Value back to a standby split flow rate of 15 – 20
mL/min and click on the Add button.

Method Editor - Instrument Control – Instrument Timed Events – Gas Saving mode.
16
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5. Instrument Control Options – Inst Timed Events - continued
Note: When setting up the split flow gas saving mode you should also set
the Split Control – Flow (mL/min) to a low flow rate in the
Carrier tab screen to save carrier gas when the GC is not in the
Ready state (standby).
Step 2. Set the Carrier - Split Flow for gas saving in
standby.
a. Set the Split Control - Flow (mL/min) of the carrier
gas to 15 - 20 mL/min to save carrier gas during standby.
Note: This setup can only be used on a GC equipped with programmable
pressure control (PPC) of the carrier gas.

Method Editor – Instrument – Control Options – Split Control – Gas saver mode.

Important Note: This split flow saving mode may cause baseline upsets if
you are using a flow sensitive detector such as an ECD or TCD detector.
17
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6. Process Options – Integration – Noise Threshold
The Method Process -Integration parameters determine how the baseline
is drawn under your peaks of interest.
1. Noise threshold parameter.
Tip #16 - The Noise threshold parameter controls where
the start and end points are located for peak detection, i.e.
where the peak baseline is drawn.
a. Higher numbers for the Noise threshold will move the peak start and
end points in toward the crest of the peak.
b. Lower numbers will move the peak start and end points away from the
crest of the peak.

Method – Process parameters – Integration tab – Noise threshold
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7. Process Options – Integration – Area Threshold
The Method Process -Integration parameters determine how the baseline
is drawn under your peaks of interest.
2. Area threshold parameter.
Tip #17 - The Area threshold parameter controls whether
a peak will be integrated as a peak of interest or eliminated
as noise.
a. Lower numbers for the Area threshold will allow integration of smaller
peaks.
b. Higher numbers for the Area threshold will eliminate small noise (or
sample) peaks on the baseline.

Method – Process parameters – Integration tab – Area threshold

Note:

A ratio of 1:5 is recommended for the Noise to Area threshold
settings.
19
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8. Process Options – Baseline Timed Events
Tip #18 - You can setup the method to automatically ignore the integration
of the solvent peak and other baseline upsets using the Process
-Baseline Timed Events functions.
3. Locking out integration of the solvent peak.
a. Click on the Process drop-down menu.
b. Select Baseline Timed Events.
c. Select the Disable Peak Detection (-P) function with the Event browse
button. Set the Time to 0 (zero) (min) and click on the Add button.
d. Select the Enable Peak Detection (+P) function with the Event browse
button. Set the Time to after the crest of the solvent peak and click on
the Add button.

Method Editor - Process Menu – Baseline Timed Events – Peak Detection.

Note: Use Timed-Events sparingly and only when necessary. As the
column ages component retention times may shift unlike the
timed events that are at fixed times in the method.
20
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9. Process Options – Replot
Tip #19 - The method replot parameters for your chromatogram printout
can be modified from the default options in Process - Replot.
4. Replot Settings Optimization.
a. Uncheck the Generate a separate replot. Note: Be
sure to add Print a Plot with Report in the Report Format
file that is associated with your method.
b. Set the Retention Labels to Peak crests.
c. Set the Scaling Type to Absolute scaling, and set the Full scale
(mV) for your desired plot display. This will fix the vertical axis of the
chromatogram replot so that you can visually compare chromatograms.

Method Editor – Instrument – Control Options – Split Control – Gas saver mode.

Important Note: Always check that your largest peak of interest is on
scale at or below 500 mV. This will prevent the clipping
of your peaks and loss of data.
21
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10. Components – Global Information
The method Global Information options must be selected for method
calibration type and auto-calibration.
1. Calibration type selection.
a. In the window you can choose between the External or
Internal standard calibration calculations.
Tip #20 – Select the “Reject outliers during calibration” feature to
automatically reject calibration results that deviate by more
then the allowed % entered for this option. This is very useful
for method calibration runs that are added to a long sample
analysis sequence or auto-calibration sequences.

Method Editor – Component – Global Options – Calibration type/Reject outliers.

22

Chromlab

TotalChrom Operational Notes

Chapter 2 – Method Tips
11. Components – Component Defaults
Tip #21 - The Component Defaults values for component identification and
calibration may be added. Entering these before adding any
components to the method will greatly speed up data entry of a
component list with multiple entries.
Note: These default values must be entered BEFORE any components are
added to a new method. If these defaults values are not entered before
entering components they will not be applied automatically.
2. Component Defaults - Identification
a. Enter an Absolute window value for component ID. This
value is in seconds around both sides of the crest of each
component.
b. Turn off the Relative window to remove this parameter from the
component ID calculations to simplify the ID window calculation.

Method Editor – Component Defaults – Component ID windows and References.

Tip #22 – Check the “Find tallest peak in window” function so that the
ID software will find the tallest peak in the window as apposed
to the default which is the peak closest to the middle of the
window.
23
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11. Components – Component Defaults - continued
Note: Remember that any default values must be entered BEFORE any
components are added to a new method.
2. Component Defaults - Calibration
a. Select the Calibration Type, use Avg calibration factor
for a single level calibration. Select Use curve for multilevel calibration methods.
b. Enter the calibration Level names, Amounts and choose whether to
Include or to Force the origin.

Method Editor – Component Defaults – Calibration using multiple levels.

Tip #23 – To prevent results calculated by using a curve fit from giving
negative values, choose Force for the Origin Treatment.
24
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12. Report Format Editor
The Report Format Editor is used to build the Report file (.RPT) that controls
what data is included in the printed report.
Tip #24 - It is a good practice to use the same file name for the Report file
as was used for the Method file and to store it in the same
directory as the Method file.
Note: If TotalChrom can not find the method Report file it will use the Default
Report.

1. Using Report Format Editor.
a. Generate a method with components and calibration
information.
b. Click on the Other menu in the Method Editor window and choose the
Report Format Editor function.
c. The Report Format displayed for a new method is the Default Report.

Method Editor – Other – Report Format Editor
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12. Report Format Editor - continued
Tip #25 - An easy way to create a new external or internal standard Report
Format file is to use the templates stored in the TotalChrom
Examples directory.
2. Using Report Format templates.
a. Click on the File drop-down menu in the Report Format
Editor window.
b. Select the Open function.
c. Click on the Quick paths browse button and select the TotalChrom
Examples directory path: C:\PenExe\TcWS\Ver6.3\Examples.
d. Select the ISTD.RPT for internal standard calibration report format or
EXTD.RPT for external standard calibration report format.

Report Format Editor – File – Open – TotalChrom Examples Directory
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12. Report Format Editor - continued
Tip #26 - When using the templates stored in the TotalChrom Examples
directory be careful not to modify the template file itself or it will
not be available for the next user. Save the Examples template
to your method name and path before editing this file. Do not
overwrite the template files!
2. Using Report Format templates - continued.
a. Use File/Save as to save the Examples template format with
the method name that you are developing.
The following modifications to the default report are suggested.
b. Select the Options drop-down menu and select Small for System Header.
c. Select Use normal font when possible for Compressed Mode.
d. Check the Print replot with report in Miscellaneous Options to create a
one-page report with the chromatogram on the same page as the results.

Report Format Options
27
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12. Report Format Editor - continued
Tip #27 - All of the fields and columns in a Report Format file can be edited by
the user. Simply click on a field and edit it as desired.
3. Editing the Report Format file.
a. Delete all the extra columns in the report format until the
report font is no longer compressed.
b. Click on the format Title and enter your report name.
c. Click on a column label to modify a column label name.
c. Change the number of Digits to display after the decimal point in a data
column with the Replace command.
d. The columns may be rearranged using the Move command.
e. Click on File and Save the modifications to your report format file.

Report Format Editing
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13. Components – Calibrate
Tip #28 - The Components - Calibrate function allows the user to
calibrate a method manually. This function is very useful for
initial calibration of the method to check that all parameters are
entered correctly.
1. Using the Method Calibration function.
a. In the Components drop-down menu click on Calibrate.
b. Select a calibration standard data file that was previously
run using the browse button.
c. In the Calibration Parameters box, select the Level name, Calibration
Type – Average or Replace and click on the Add button.
d. Click on the OK button to perform the method calibration.

Method Editor – Components - Calibrate – Manual Calibration.
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14. Other – Fit Analysis (CalPlot)
Tip #29 - When performing a multi-level calibration you can review the
calibration curve data stored in the method using the Fit
Analysis function to check for out-laying data points and curve
linearity (R-Squared results).
1. Calibration Review – Fit Analysis.
a. In the Other drop-down menu, click on Fit Analysis
(CalPlot).
b. The R-Squared results are displayed in the bottom right-hand corner of
the window.
c. The calibration curve information may also be reviewed by selecting Fit
Type drop-down menu and selecting Curve Info.

Method Editor – Other – Fit Analysis (CalPlot).
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Chapter 3 – Graphic Method Editor Tips
1. Graphic Method Editor
Tip #30 - Use the Graphic Method Editor - Display functions to view the
actual data points collected in any raw data file. This function will allow you
to optimize the data sampling rate parameter for acquiring data.
1. Display Raw Data Points
In the TotalChrom Navigator screen single click on the
Graphic Edit button. Click on the Display drop-down
menu and select the Raw Points function.
Your raw data files will now be displayed showing the actual data points.

Graphic Method Editor – Display - Raw Points screen.

Tip #31 - One way to access the Graphic Editor is from the Method Editor
screen. Using this technique, you will not need to re-select your
method file name in the Graphic Editor.
Click on the Other drop-down menu in the Method Editor and
select Graph Editor.
31
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2. Graphic Method Editor - Bunching factor
Tip #32 - You can optimize the bunching factor applied to the data points
collected in a raw data file using the Graphic Method Editor.
1. Bunching Factor – manual optimization
The TotalChrom Bunching factor is used to generate
average data points which in turn will help to remove
baseline noise and spikes.
Tip #33 - It is recommended that the maximum Bunching factor never
exceed a value of 3 – 5 points. Reduce the Sampling Rate value if higher
bunching factors are indicated.

At a Bunch factor of 2 the
number of bunched points
is one half of the number
of raw data points.

Graphic Method Editor – Display - Raw Points with Bunching

Tip #34 – The optimum points/peak is 15 - 40 bunched (averaged) points.
Bunch factor values of 2 or 3 (average of every 2 or 3 data points) can also be
used to improve the baseline placement and peak integration results.
32
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2. Graphic Method Editor - Bunching factor – continued
Tip #35 - You can optimize the Bunching Factor automatically with the
Process - Sampling Rate/Bunching Factor function.
2. Optimize the Bunching Factor automatically.
a. Click on the Process drop-down menu and select the
Sampling Rate/Bunching Factor.

Graphic Method Editor -Process Menu – Sampling Rate/Bunching Factor.

b. Using the mouse, rubber box the narrowest peak of interest at its
baseline. DO NOT include peak pre/post tail area.
Use the Process function
Sampling Rate/Bunching
Factor to automatically
calculate the Bunch Factor.
Using the mouse, rubber box
the peak width at its baseline.

Graphic Method Editor – Process – Rubber boxing the baseline.

Important Note: If a bunch factor higher that 2 or 3 is calculated to achieve
20 – 40 bunched points it is better to reduce the Sampling Rate parameter.

33
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3. Graphic Method Editor – Noise/Area Threshold
Tip #36 - You can optimize the Noise and Area thresholds automatically to
remove excessive numbers of noise peaks from the
chromatogram with the Noise/Area Threshold function.
1. Optimize the Noise/Area Thresholds.
a. Click on the Process drop-down menu and select
Noise/Area Threshold.

b. Using the mouse, rubber box to highlight a section of baseline noise. DO
NOT include peaks.

Process Menu – Noise/Area Threshold.

Note: A ratio of 1 to 5 is recommended for the Noise and Area Thresholds.
34
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4. Graphic Method Editor – Component Editing
Tip #37 - A fast and easy way to update or even generate a method
component list is by using the Graphic Editor Calibration – Edit
Components functions.
1. Graphic Component Editing
a. Click on the Calibration drop-down menu and select Edit
Components.
b. Using the mouse, rubber box to highlight a section of
chromatogram to update.
c. Click on a component that was not identified correctly due to a retention
time shift. The peak will be enclosed in a dotted line box.
d. In the Name window click on the browse button to open the list of your
component names. Select the component name of interest and click on
the Next button.

Graphic Method Editor - Calibration – Edit Components
35
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5. Graphic Method Editor – Calibration
Tip #38 - One easy way to manually calibrate a method is with the Graphic
Method Editor Calibration - Calibrate function.
1. Manual Calibration.
a. Click on the Calibration drop-down menu and select
Calibrate.

Calibration – Calibrate

b. Select the Calibration level.
c. Select the Mode, either Average or Replace.
d. Click on the OK button. The method is calibrated with the parameters
selected.
e. Click on the File, Save to save your calibration.
Important Note:

Check to be sure that the data file currently being
viewed in the Graphic Method Editor is a calibration
standard run before using the Calibrate function.

36

Chromlab

TotalChrom Operational Notes

Chapter 4
Chapter 4 – Sequence Editor Tips
1. Sequence Editor – Auto-Calibration Sequence
Tip #39 - You can automatically calibrate your method with a sequence
setup for auto-calibration. This is a fast and easy way to recalibrate your method when using an autosampler to inject your
samples.
1. Create an Auto-Calibration Sequence
a. In the TotalChrom Navigator screen, click on the
Sequence button.
b. Load or Create a Sequence that uses the method you
wish to calibrate automatically.
c. The example below shows a three injection sequence which will generate
average response factors for all components in the method.
d. Save your auto-calibration sequence with the method name included in
the auto-calibration sequence name for easy identification.
Example Name: Retained Solvent Auto-Calibration.seq

Sequence Editor – Auto-calibration sequence for average response factors.

Important Note: Double check to be sure that the sample vials in the
autosampler tray positions to be analyzed are indeed
the calibration standards to be run before using this
auto-calibration sequence. A method that is
calibrated with the wrong samples will give
erroneous results.
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2. Sequence Editor – Smart Fill
Tip #40 - Use the Smart Fill function to easily update or change the data
file names in your sequence. This is a fast way to re-name your data files
with unique names so that they can be located easily for future reference.
1. Use Smart Fill to edit Sequence Data File Names.
a. Load or Create a Sequence.
b. Right click in the Data column and select Smart Fill.

c. Enter the Starting Row, Ending Row, Directory and Edit the Base
file name as necessary to give your data files unique names.
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3. Sequence Editor Shortcuts – Actions - Setup
Tip #41 - The shortcut for sequence setup is located in the Sequence Editor
Actions drop-down menu. With this shortcut the sequence file
will not need to be re-selected. This is a fast and easy way to
set-up your sequence without leaving the sequence screen.
1. Using the Actions - Set-Up function.
a. Click on the Actions drop-down menu in the Sequence
Editor screen.
b. Select the Set Up function.

Sequence Editor – Actions – Set Up function.

2. Using additional Actions menu shortcuts.
You can also use the sequence Actions menu to open Batch or the method
editor.
a. Click on the Batch function to get to Batch reprocess your data files.
b. Click on the Method Edit function to return to your method for
additional modifications or manual calibration.
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4. Sequence Editor Shortcuts – Build – Append New Cycles
Tip #42 - The shortcut for adding new cycles (Sample rows) to a sequence
is located in the Sequence Editor Build drop-down menu. This is
a fast and easy way to append additional samples to your
sequence.
Remember that a “Cycle” in TotalChrom is really synonymous for Row #
during the initial running of the sequence.

1. Using Build - Append New Cycles function.
a. Click on the Build drop-down menu in the Sequence
Editor screen.
b. Click on the Append New Cycles function.

Sequence Editor – Build – Append New Cycles (samples) function.
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4. Sequence Editor Shortcuts - Append New Cycles - continued
This shortcut will add new sample rows using the current method and report
files and will automatically increment the data file names.
Note: The Vial number is not automatically incremented in the sequence
when using this function. This will need to be changed manually or by
clicking on Smart Fill in the vial column.
2. Set the Append New Cycles parameters.
a. Click the Type browse button to select your sample type.
b. Enter the # of cycles (sample rows) to be added.
c. Type in your new sample name in the Name field.
d. Click the Add + Close button to add the new cycles to your sequence.
e. Review the added sample rows and update the name and vial number,
as necessary.

Sequence Editor – Build – Append New Cycles (samples) function.
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1. Results Reprocess
Tip #43 - Results Reprocess can be used to review an individual data file.
You use these functions to manually preview, print, draw a
component baseline, optimize the integration parameters and
display the results from a data file.
Note: Results Reprocess changes to a data file DO NOT affect the stored
method integration values!
1. Manual Integration.
Use manual integration to re-draw the baseline under a
peak of interest.
a. Click the Process drop-down menu.
b. Select Manual Integration.
c. Place the + cursor on the baseline, in front of the peak of interest, click
and drag the new baseline to a point after the peak.
e. Review your new peak area in either Display/Peak Report or with
File/Print Preview Report.

Reprocess Results – Process – Manual Integration.
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1. Results Reprocess - continued
2. Delete Baseline Events.
While using the manual integration to re-draw the baseline
you may need to delete the manual baseline events during
optimization of the baseline.
a. Click the Process drop-down menu.
b. Select Baseline Events.
c. Click on the Delete Events function.
d. Click on the OK button.
e. Redraw the manual baseline as necessary.

Reprocess Results – Process – Delete Baseline Event.

Important Note: Use caution whenever adding baseline events to a
method. These events are fixed in time and DO NOT
move automatically. Therefore, if a component retention
shifts in time, as for instance when a column ages, fixed
events may cause the baseline to be drawn incorrectly
and improperly integrated!
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2. Batch Reprocess
Tip #44 - Batch Reprocess can be used to automatically re-integrate an
individual data file, a group of data files with the same name
prefix or a sequence.
1. Batch Reprocess
Batch Reprocess is usually performed after method
integration parameters have been optimized in the method
either manually or by using the Graphic Method Editor.
a. In the TC Navigator screen click on Batch Reprocess.
b. Click on the Three Vial Icon or click on File/Sequence.
c. Select your Sequence file using the browse button.
d. Choose your Actual data path with the browse button.
e. Check the Overwrite existing result files option.

Batch reprocess – From Sequence

Note: Select None for the Batch printer to reprocess the data files only,
without reprinting the results.
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2. Batch Reprocess – continued
Tip #45 - If you reuse the same sequence over and over again as a
template to collect data for numerous runs it may be easier to
find your data using a sequence index file. A sequence index file
is created each and every time a sequence is run.
1. Using Sequence Index (*.idx) Files.
Locate the sequence index files as follows:
a. In the Batch - From Sequence window click on the
Sequence file browse button.
b. The TotalChrom File-Open window is displayed.
c. Click on the Files of type: browse button and select Index Files[*.idx]
files.

Batch Reprocessing – From Sequence – Files of type
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2. Batch Reprocess – continued
3. Start Batch Reprocessing.
a. Review the data files in the Batch Reprocessing
window that is displayed.
b. Click on the green - Start icon to start the
reprocessing of the selected files.
c. The data files selected will be reprocessed and the results printed if a
new printout is called for by selecting a printer on the Batch screen.

Batch Reprocessing – Start

46

Chromlab

TotalChrom Operational Notes

Chapter 6
Chapter 6 – Chromatograms
1. Chromatograms - Overlay
Tip #46 - Using Chromatograms – Overlay you can select two or more
chromatogram files and overlay them for visual inspection.
1. Using Chromatograms - Overlay.
Locate the data files of interest in the File - Open
TotalChrom Multiple-File-Open window.
a. Use shift-click or the control click to select two
or more files.
b. Click on the Window drop-down menu and check (√) the Overlay
function.
c. Maximize the Overlay View to see the overlay in full screen.

Chromatograms – Overlay
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1. Chromatograms – Auto Size
Tip #47 - With Chromatograms – Auto Size you can expand all
selected chromatograms displayed to see the chromatogram
details more easily.
2. Using Chromatograms – Auto Size.
Select the data files of interest in the File - Open
TotalChrom Multiple-File-Open window.
a. Click on the Window drop-down menu and check
(√) the Auto Size function.
b. Use the rubber box function, left-click and drag to expand a section
of interest in one chromatogram.
c. Right-click in a chromatogram to Undo the expansion.

Chromatograms – Auto Size
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1. Method Editor – Component List View
Tip #48 - Using the Method Editor - Component List view you can
display the method component list, the calibration parameters
and the calibration curve together on the screen to more easily
review the calibration results.
1. Using Method Editor – Component List View.
a. Open the Method Editor screen.
b. Click on the Window drop-down menu and select
Component List.

Method Editor – Component List screen
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2. Real-Time Plot
Tip #49 – In the Real Time plot mode you can capture the data that has
been collected up to that point in the run for review and
optimization in the Graphic Method Editor.
1. Using Real-Time Plot – Review Application
a. Open the Real-Time Plot screen.
b. Click on the Apps drop-down menu and select
Analyze A.
c. Your data will appear in the Graphic Method Editor screen.

Real Time Plot – Apps – Analyze A
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3. Unlocking Methods and Sequences
Tip #50 – If opening a method or sequence displays an error message
that will only allow you to open the file as a read-only file you
must remove the system ”locks”.
1. Using CAM Administration to remove Method locks
Use the following steps to remove method or sequence locks.
a. In the Admin drop-down menu and select CAM Administration.
b. The CAM Admin Tool screen is displayed.
c. Open the current TotalChrom User by clicking on the
left of Users.

+ box to the

d. If any sequences or methods are displayed in the right side of the
screen, click on the Unlock icon on the left side of the icon bar to
remove the locks.
e. Click on File – Exit to close the CAM Admin Tool.

CAM Administration Tool – Used to remove method or sequence locks
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4. Kickoff – Simplified User Interface
Tip #51 - TotalChrom includes a Simplified User Interface (SUI)
application called Kickoff™. After configuration this
application will allow the user to setup TotalChrom methods or
sequences quickly and easily. The user will have see any
Method, Sequence or the standard Setup functions.
1. Using Kickoff – First screen.
a. In the Navigator screen click on the Apps drop-down menu.
b. Select Kickoff.
c. Highlight the analysis you want and press the Continue.
Note: This and the following Kickoff screens are an example of a
Kickoff - Method Setup.

Kickoff - Simplified Use Interface Application – First screen.
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4. Kickoff – Simplified User Interface - continued
The Kickoff application is very easy to configure and use. The Kickoff
Analysis name can be configured to the original method or sequence
name for ease of use.
2. Using Kickoff – Second screen.
In the analysis screen enter the sample information.
a. How many samples do you want to run?
b. How many injections of each sample?
c. Click the Continue button to proceed to the next screen.

Kickoff - Simplified Use Interface Application – Second screen.
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4. Kickoff – Simplified User Interface - continued
The Kickoff application is very easy to configure and use. The Kickoff
Analysis name can be configured to the original method or sequence
name for ease of use.
3. Using Kickoff – Third screen.
In the final Kickoff - Method setup screen customizable prompts are
displayed for the user.
a. Click on the Finish button to complete the Kickoff setup.
Note: When using Kickoff – Method setup the data file name is
automatically generated using the Kickoff name appended with the
date and time of each injection. The data file is automatically
stored in the default Data Directory.

Kickoff - Simplified Use Interface Application – Third screen.
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4. Kickoff – Simplified User Interface - continued
The TotalChrom Kickoff application configured for a Sequence setup uses
a previously generated sequence. This allows the user to pre-define the
data file names and the set the data path in advance.
4. Using Kickoff – Sequence Setup.
a. Select the Kickoff – Sequence analysis to be setup.
Note: When using Kickoff – Sequence setup the data file name is
pre-defined in the sequence for each injection. However, for all
subsequent Kickoff analysis the data file name is appended with a
date and time stamp. The data file is automatically stored in the data
directory defined in the sequence.

Kickoff Sequence setup - Simplified Use Interface Application.
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ChromLab - On-Site TotalChrom Training Programs
On-site TotalChrom™ operator training programs can be scheduled at
your laboratory location.
These hands-on training programs are designed to assist your
personnel to utilize the software features described herein to
generate, optimize and calibrate quantitative methods for your GC or
HPLC applications.
If you would like information of these customized, on-site training
programs please contact ChromLab at 610-644-2260 or online at
www.FastGCChromLab.com.
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Disclaimer: ChromLab provides the descriptions, data and information
contained herein in good faith but makes no representation as to its
comprehensiveness or accuracy. It is provided for your guidance only.
Because many factors may affect processing or application/use, ChromLab
recommends you perform an assessment to determine the suitability of the
descriptions, data and information for your particular purpose prior to use.
No warranties of any kind, either expressed or implied, including fitness for a
particular purpose, are made regarding the software features described, data
or information set forth. In as much as the operating and instrumentation
control software described herein is not under the control of ChromLab, in no
case shall ChromLab be liable for errors in the descriptions, data or
information contained herein and for any damages, incidental or
consequential in connection with furnishing, or use of this material. Further,
the descriptions, data and information furnished herein are given gratis. No
obligation or liability for the description, data and information given are
assumed. All such being given and accepted at your risk.
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